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Chapter 1

First chapter

1.1 Lorem ipsum

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Quisque lectus mi, ali-
quet ac lectus at, luctus ornare enim. Donec eleifend ornare ante. Curabitur non
adipiscing risus. Vivamus congue sem non magna tristique, ut pellentesque diam
ornare. Donec eget arcu congue, vulputate nisl et, aliquam tellus. Morbi tincidunt
odio quis mi hendrerit aliquet sit amet sit amet lorem. Donec fringilla nec lectus
nec lacinia. Aliquam eu nunc euismod, tempus neque in, consequat velit. Duis arcu
quam, convallis quis ultricies vitae, semper in est. Aliquam congue sagittis tortor,
eget blandit lorem ullamcorper id. Maecenas venenatis nec neque in consectetur.
Nulla nisl turpis, elementum a enim interdum, tincidunt vehicula tortor. Praesent
pulvinar mi sit amet condimentum placerat. Curabitur mollis libero non auctor
condimentum. Suspendisse ante lectus, sodales vel mauris vel, pharetra laoreet eros.

Nam lacinia nunc lorem, adipiscing ornare purus semper sit amet. Morbi ele-
mentum augue vitae purus vehicula, ac varius leo sagittis. Vestibulum eu orci in
ipsum suscipit posuere. Nulla quis erat rhoncus risus rutrum venenatis vel at lectus.
Vivamus pharetra tempor rhoncus. Proin vitae turpis vitae lacus ultrices lacinia eu
ac nunc. Morbi id metus purus. Pellentesque facilisis at arcu ut adipiscing. Etiam eu
nisi hendrerit, congue orci non, vehicula orci. Interdum et malesuada fames ac ante
ipsum primis in faucibus. Aenean porttitor eu velit sed pulvinar. Class aptent taciti
sociosqu ad litora torquent per conubia nostra, per inceptos himenaeos. Maecenas ut
pretium nisi, nec aliquam massa. Maecenas vitae rhoncus lacus, non tempus turpis.

Nam luctus in nisi dignissim congue. Nullam dapibus dui sed ligula euismod
congue. Nulla vestibulum, justo a feugiat porttitor, massa nunc molestie lectus,
ultrices tempus turpis massa posuere augue. Phasellus pulvinar vulputate ipsum,
et eleifend sapien mollis vel. Sed vitae eros id sapien dictum ultricies. Aliquam
ultricies nisl et bibendum imperdiet. Cras a sem eros. Quisque ut mauris a libero

hendrerit tincidunt ac ac mi. Mauris feugiat est sem, eu malesuada ipsum faucibus



1.1. Lorem ipsum

id. Duis at ante et justo ullamcorper hendrerit sed ut turpis. Donec eu dolor ac enim
venenatis placerat venenatis vitae velit. Curabitur lacus nisi, molestie id ligula vel,
congue porta felis. Nam eu aliquam justo. Mauris sapien nulla, accumsan id eros a,
porttitor interdum nunc.

Vestibulum aliquam et mauris imperdiet consectetur. Pellentesque convallis me-
tus dignissim neque tincidunt, egestas commodo odio rhoncus. Integer purus leo,
posuere non leo eget, aliquet condimentum neque. Quisque non hendrerit quam.
Phasellus sit amet neque quam. Suspendisse at sollicitudin ante. Mauris fermentum
turpis eget sem cursus tempor. Fusce ac rutrum libero, sed adipiscing diam.

Praesent quis ultricies diam, in hendrerit nibh. Praesent diam dolor, bibendum sit
amet pharetra a, viverra vel tortor. Mauris id eleifend diam. Maecenas tristique est
massa, et lacinia ante tristique nec. Praesent sapien odio, iaculis sollicitudin tristique
vitae, mattis non lacus. Ut vehicula enim pellentesque, mollis ante vitae, mollis
mauris. Aenean imperdiet tellus lorem, eget malesuada ante rhoncus id. Pellentesque
dignissim nisl id pretium condimentum. Sed congue commodo massa in rhoncus.
Phasellus elementum sollicitudin erat id rhoncus. Fusce sem nunc, semper at tempor
sit amet, congue nec orci. Vivamus a egestas dui, vel viverra eros. Sed sit amet eros
sit amet nisi gravida ullamcorper. Nam rutrum in mi sit amet vulputate. Aenean
pellentesque velit eu nisi eleifend faucibus sit amet vel dui. Pellentesque sapien est,

auctor at fringilla vel, vehicula ut urna [1].



Chapter 2
Second chapter

These are general tips about few IXTEX and LyX functionalities.

2.1 Copy and paste raw ETEX code

Sometimes it is necessary to insert raw IXTEX code in your document, IxX has
a dedicated environment for that (Insert > Tex code). By using the paste command
(CTRL + V) to copy text into that type of environment, you get as result that
everything is copied in a single line, all the carriage returns are ignored. To paste
exactly what you have copied, use the special paste command which preserves the
text formatting (CTRL + SHIFT + V or Edit > Paste Special >Plain Text).

2.2 Labels and cross-references

Labels are necessary to add cross-references in your thesis, use a label for each
element that you have to reference to (Insert > Label/Cross-reference). These elements

are manly chapters, sections, subsections, figures, tables and algorithms.

This is Chapter [2| Section [2.2]

2.3 Figures

Figures, but also tables and algorithms, must be placed inside a floating environ-
ment. This type of M TEX environment is very useful and automagically mix up text
and images. Usually the Here if possible placement option is good for all images (right
click on float: Figure then Settings). However, if the figure is not placed correctly you
may enable the Ignore IATEX rules option, usually that option solves every problem.

Figure shows an example of a very nice animal.

A rarely known feature of IxX is the possibility to add the short caption. The

short caption is the description of the figure used in the List of Figures section.



2.3. Figures

Figure 2.1: Detailed caption of this marvelous animal

Sometimes captions can be very long, in this case it is better to use a shorter one
that is more readable in the page that lists all the figures. To add this caption, right
click on the description of figure, then Insert short title.

It is not mandatory to add the short caption, it is only useful with very long

captions to ensure a better legibility of the List of Figures section.

2.3.1 Subfigures

A very cool feature of IWTREX’s figures is the possibility to have subfigures. For
example, if there are two figures that represent the result of a test executed with
two different values of a parameter, then a subfigure is a good way to organize the
images.

Figure 2.2]is an example of these subfigures. References can be added to either
the whole figure (Figure or each subfigure (Figure and Figure .

(a) A nice squirrel (b) A beautiful peacock

Figure 2.2: Fauna



2.4. Tables

2.4 Tables

The caption of tables must be placed before the table itself and not after. As for
figures, tables can have a short caption that is used in the List of Tables section.

Academic publications, but also thesis, often use the so-called «formal table», an
example of these particular style is showed in Table

Table 2.1: Detailed caption of this beautiful table

Category
first second Number Complexity
Item A « B 4 Q(n)
Item B ~ ) 2 Q (n2)

To set this particular style, right click in a cell of the table then More > Settings

> Border, here you can select the formal style.

2.4.1 Wide tables

Sometimes tables are too wide for the column’s width of the page. Rather than
changing the table’s content you can shrink it to fit the available space. The font
size will be smaller but this is, in general, a good method to fix too wide tables such

as Table the result is showed in Table [2.3]

Table 2.2: This table is very wide

Method Parameter one Parameter two Parameter three Parameter four

A 1 2 3 4
B 5 7 9 11

Table 2.3: This table is shrunk to fit the column’s width

Method Parameter one Parameter two Parameter three Parameter four

A 1 2 3 4
B ) 7 9 11

Another solution is to set the width of table’s columns. To set it, right click in a
cell of the table then More > Settings > Table settings, here you can set the width.
2.4.2 Space between rows

Another common problem with tables is when rows of the table are too close

together, this problem is very frequent when rows contain mathematical expressions
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such as Table[2.4] With a simple command it is possible to increase the space between
rows as showed in Table 25

Table 2.4: This table is a bit tight

Name Formula

1;2
Gaussian integral fo Ce 2dx =
. ")
Taylor series S, L a) (x —a)"

n=»

Table 2.5: Math cheatsheet

Name Formula

@

2
. . —+o0 _L l
Gaussian integral fo 2dx = 3

(n
Taylor series ZZO 0 ! n)!(a) (z —

Q
S~—
3

2.5 Algorithms

If you have to add some algorithms there is a dedicated IyX environment. As
for tables, the caption of an algorithm must be placed before the pseudo code of
the algorithm, short captions can be used also for algorithm. This placement of
the caption may sound strange but is justified by the fact that algorithms, but also
tables, are read from the top down, so the description must be placed before the
content. On the other side, figures are viewed like a painting, so the description

must be placed below the content.

Algorithm 2.1 Detailed caption of this complicated algorithm
1. Wake up

(a) drink a coffee

(b) brush your teeth

2. Go to work
3. Come back home

4. Go to sleep

Unfortunately [y X does not support algorithm commands offered by some IXTEX
packages (\If, \While, ...) out of the box. It is possible to use custom modules

to handle those commands or use the 2.1 beta version that supports some of them



2.6. Source code

but, as for now, it is better to write directly I¥TEX code. This template uses the
algorithmicx package, refer to the manual of that package (http://www.ctan.org/
pkg/algorithmicx) for the documentation of all the commands. Algorithm

shows an example of the usage of some commands of the algorithmicx package.

Algorithm 2.2 Best algorithm ever

1: s < ALIVE > Day of birth
2: while s # EOL do
repeat > Early morning, possibly

3
4 Try to wake up

5 until s = SLEEP

6: Drink a coffe > Even more than one
7 Brush your teeth

8 Go to work > With a smile on your face
9: Come back home
10: Go to sleep
11: end while

2.6 Source code

You may need to add some pieces of source code that you have written. LyX uses
listings package to provide a customized environment to insert source code (Insert >
Program Listing). Listings can have a caption, but LyX does not add it by default,
if you want you can insert it (place the cursor inside the listing environment, then
Insert > Caption).

By default, the result that you get is pretty ugly as you can see in the Listing
211

Listing 2.1: Program that computes your degree mark

#include <stdlib .h>
#include <stdio.h>

/ %k

* Main program

*/

int main(int argc, char =xargv|]|)

{
long double degree mark = 0x42 % 042 % 0b00101010 * 0.001167;

printf (" Congratulations for your degree\n");
printf (" Your mark is %—3.0LfL\n", degree_ mark);


http://www.ctan.org/pkg/algorithmicx
http://www.ctan.org/pkg/algorithmicx

2.6. Source code

return EXIT SUCCESS;

You need to set a couple of options (right click inside the source code environment,

then Settings) to get a good looking result. The most important options are

Font style use a fixed-length font (Font Family: Typewriter), it is useful to set a
Small font size to compact large pieces of source code. Breaking long lines is
very important as well as hiding nasty spaces (check Break long lines option,
uncheck Space as symbol and Space in strings as symbol options, set Tabular size
to 4)

Line numbering having the line numbering active is useful if you have to refer to

a particular statement when you are describing you code

Language setting the proper language is important to have the correct syntax high-

lighting

The Listing has the same code as the Listing but it has all the options

mentioned before adjusted, the result is way better that the other.

Listing 2.2: Program that computes your degree mark

1 #include <stdlib.h>

2 #include <stdio.h>

3

4 /*x

5 * Main program

6 */

7 int main(int argc, char *argv[])

8 {

9 long double degree_mark = 0x42 * 042 * 0b00101010 =
0.001167;

10

11 printf ("Congratulations for your degree\n");

12 printf ("Your mark is %-3.0LfL\n", degree_mark);

13

14 return EXIT_SUCCESS;

15}

If you have to insert more than one piece of code it can be useful to copy the
previously created environment and then modify it. This saves you from setting the

options every time you insert a new listing.



2.7. URLs

2.7 URLs

IyX has a dedicated command to insert URLs (Insert > URL) that must be used
to insert each URL. The environment automatically uses a typewrite font for the
text, inserts a hyperlink to the URL and, most importantly, breaks long URLs in
multiple lines.
This is a URL added as simple text, http://this.is.not.the.correct.way.to.add.urls.in.lyx.documents.htm
This is a URL created with the url command, http://this.is.the.correct.
way.to.add.urls.in.lyx.documents.html.
The url environment can be manually used, for example, in the bibliography
where URLs are not handled in a dedicated way. The Listing [2.3] shows how to use
the url command in the bibliography.

Listing 2.3: How to insert URLs in the bibliography

1 % this URL will not be broken into multiple lines and
2 % will NOT have a hyperlink

3 Qarticleq

4

5 howpublished = {http://google.com}

6 1}

7

8 % this URL WILL be broken into multiple lines and
9 % WILL have a hyperlink

10 @article{

11

12 howpublished = {\url{http://google.com}}

13 3

2.8 LyX’s guides

LyX has a series of guides that describe all its features, if want to exploit all the
available functionalities you need to read them. Those manuals are available directly

in IxX (for example, Help > Embedded Objects).

10


http://this.is.the.correct.way.to.add.urls.in.lyx.documents.html
http://this.is.the.correct.way.to.add.urls.in.lyx.documents.html

Chapter 3

Third chapter

These are very personal suggestions, no offense will be taken if you completely

ignore this chapter.

3.1 Manage bibliography

Manage a lot of bibliography resources by manually editing a bibtex file is very
annoying, it is better to use something that manages for you all the references. Sadly,
LyX does not have an easy to use system for doing that. However, there are other
programs that can be used to automagically organize dozens of papers.

There are two famous programs, referencer and JabRef (https://launchpad.
net/referencer, http://jabref.sourceforge.net/), both have a lot of useful

features, the most notable are
e copy from clipboard of bibtex formatted references
e organization of references with labels
e possibility to associate a pdf to each reference

o the Cite in LyX button

3.2 Reviews

Your advisor will review what are you writing and he will, most likely, add
annotations on a pdf. However, correction contained inside annotations are difficult
to integrate, manly because you will spend a lot of time in finding where to modify
your document. IyX supports a very powerful method to review a document, just
look the examples below.

Where have you learned english stupid dumbass?

The derivative of e® is 2% .

11
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3.3. Final presentation

After having considered all the other solutions we proved that this is the most
efficient way to determine the medium length of horse’s mane.

These result shows that the first method is way better than the second.
The integration of these reviews is much easier than reviews inside annotation of a
pdf. Unfortunately you have to convince your advisor to use this system, I think it
is worth a try.

This feature is called Change Tracking, there is a dedicated toolbar that you can
show by activating the Change Track option (Document > Change Tracking > Track
Changes or simply CTRL + SHIFT + E). This document has the Change Tracking

option already enabled.

3.3 Final presentation

Once you have written your thesis you will have to present it. Timing is critical.
You will have from 15 to 20 minutes to present the work of months. A very useful
tool that you may use during your presentation is pdfpc (http://davvil.github.
io/pdfpc/). By using this program, on the screen of your laptop you will have some
additional information that are not showed on the external monitor. These extra

information are

Time left you can set the duration of the presentation and see how many minutes

and seconds you have left
Next slide you will see both the current and the next slide

Annotations you can add some annotation to remember you some key points that

you may forget

This tool is very very useful, but do not forget that there is always the demo effect.
You MUST try it before even thinking to use for your final presentation.

To install the program on a Linux system there should be a package named
pdf-presenter-console, for other OS on the websites of the program there are the

instruction how to install it.

12


http://davvil.github.io/pdfpc/
http://davvil.github.io/pdfpc/

Chapter 4

Fourth chapter

These are style suggestions that you can use to personalize and beautify your

thesis.

4.1 Font

One important stylistic change that you can do is changing the font. The default

one is Computer Modern which is ok, but there are other fonts that can be used.

You can change the font in the properties of the document (Document > Settings

> Fonts). Not all the fonts can be used when compiling with pdflatex, with some
fonts you need to render the pdf with XelTEX or Lual&TEX. Figure shows two

different examples of fonts combination.

Lorem ipsum  dolor sit amet,
consectetur adipiscing elit. Quisque
lectus mi, aliquet ac lectus at, luctus
ornare enim. Donec eleifend ornare
ante. Curabitur mon adipiscing
risus (0, 1, 2, 3, 4, 5, 6,17, 8, 9).

The quick brown fox jumps over the lazy
dog.

#include <stdio.h>

int main() {
printf('Hello world\n');
return O;

}

Lorem ipsum dolor sit amet, consectetur
adipiscing elit. Quisque lectus mi, aliquet
ac lectus at, luctus ornare enim. Donec
eleifend ornare ante.  Curabitur non
adipiscing risus (0, 1, 2, 3, 4,5, 6, 7, 8, 9).

The quick brown fox jumps over
the lazy dog.

#include <stdio.h>

int main() {
printf('Hello world\n');
return 0;

3

Figure 4.1: Two different font styles

The fonts used in the example are summarized in the Table

13



4.2. Fancy chapter header

Table 4.1: Fonts used in the two examples showed before

Serif Latin Modern Roman Unslanted Gentium
Sans Serif Latin Modern Sans Demi Condensed Verdana
Typewriter Latin Modern Mono Slanted Inconsolata

If, by looking at the pdf, the letters look ugly check the property of the pdf, in
particular the type of fonts used (how to find this information depends on the pdf
viewer that you are using, if you are using Linux use pdffonts command). If your pdf
has Type 3 fonts that is the reason why your pdf looks ugly. It is better to use Type
1 fonts, if you are running IxyX on a Linux system by installing cm-super package

you can fix this problem.

4.2 Fancy chapter header

The header of each chapter can be personalized as you like, this requires you
to write a rather big amount of IXTEX code to get a nice result. However, there is
package that provides a set of predefined styles, fncychap (http://www.ctan.org/
pkg/fncychap). Figure shows just two of the styles offered by the package.

Chapter 1

Cool chapter header

(a) Lenny style

CHAPTER 1
COOL CHAPTER HEADER

(b) Conny style

Figure 4.2: Two possible styles for headers of chapters

4.3 Fancy initial letters

Another thing that can be fancied are the initial letters. This is a very simple
modification that you can do to add a personal touch to each chapter. There is a

package that permits to customize, with various options, initial letters called lettrine

14
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4.4. Fancy headers

(http://www.ctan.org/pkg/lettrine). There are a lot of options to create your

personal style for each initial, Figure [4.3| shows two possible styles of initials.

Nice initial letter. Lorem ipsum dolor sit amet, consectetuer
adipiscing elit. Ndictum Ut purus elit, vestibulum ut,
placerat ac, adipiscing vitae, felis.

\/ERY nice initial letter. Lorem ipsum dolor sit amet, con-
sectetuer adipiscing elit. Ndictum Ut purus elit, vestibulum
ut, placerat ac, adipiscing vitae, felis.

Figure 4.3: Two examples of initial letters

4.4 Fancy headers

Fancy headers are already used in this template, the package used is fancyhdr
(http://www.ctan.org/pkg/fancyhdr). There are a lot of options, this template
uses almost the standard style for the header but you can change it. For example,
you may move the page numbering from the bottom header to the top header, or
remove the horizontal line in the header, or ... . In this template the fancy header
style is set in the IXTEX preamble of the thesis.lyx document (Document > Settings
> IATEX Preamble) and just before the Introduction chapter.

4.5 Other document classes

This template uses the book class, there are some more advanced classes that
have a lot of cool features such as the one offered by koma-script or memoir (http:
//www.ctan.org/pkg/koma-script, http://www.ctan.org/pkg/memoir).

LyX supports a discrete number of those alternative classes, however to fully
exploit the additional functionalities offered by those classes you have to write raw
KTEX code. If you want to deeply customize your thesis maybe it is better if you
start considering to write it directly in IXTEX rather than using LyX.

15
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Chapter 5

Fifth chapter
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Chapter 7

Seventh chapter
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Eighth chapter
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